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Tin Câu lạc bộ - ðoàn - Khoa 

- ðoàn khoa Cơ khí phối hợp với khoa 
CNTT tổ chức cho hơn 1000 sinh viên tham dự hội 
trại nhân kỷ niệm 45 năm ngày thành lập Trường. 
Cũng trong dịp này một số sinh viên khoa Cơ khí ñã 
tham gia cuộc thi tìm hiểu 45 năm truyền thống 
trường ðại học Thủy sản  và ñạt giải nhất 

- Tổ chức thành công ðại hội ðại biểu 
ðòan khoa Cơ khí nhiệm kỳ 2004 – 2006. ðại hội 
ñã bầu Ban chấp hành  nhiệm kỳ 2004 – 2006 gồm 
13 ñồng chí với  cơ cấu phân bổ như sau : 03 Giáo 
viên, 2 sinh viên khóa 43, 2 sinh viên khóa 44, 2 
sinh viên khóa 45 và 4 sinh viên khóa 46. Bí thư : 
Trần Doãn Hùng (GV); Phó Bí thư : Nguyễn Quốc 
Huy (43CT), Ủy viên thường vụ : Nguyễn Thắng 
Xiêm (GV). 

- Một số công tác khác ñã triển khai : Thu 
ðoàn phí 6 tháng ñầu năm, thu ủng hộ trẻ em Lai 
Châu, thực hiện ñồng phục cho sinh viên K46.  

- Sáng ngày 14/11, câu lạc bộ Chế tạo máy 
ñã tổ chức cuộc thi olimpic lần 4 cho gần 170 sinh 
viên cơ khí K44 với nội dung giải chuỗi kích thước 
lắp ghép ñể xác ñịnh dung sai kích thước các ñoạn 
trục. ðây là một nội dung quan trọng giúp cho sinh 
viên xây dựng bản vẽ chế tạo chi tiết trục cho ñồ án 
môn học Chi tiết máy sau này. 

- Chiều ngày 14/11, câu lạc bộ Chế tạo máy 
ñã tổ chức giới thiệu các môn học ngành Chế tạo 
máy và những vấn ñề liên quan cho sinh viên lớp 
46CT. Các báo cáo viên ñã giới thiệu chi tiết nội 
dung các môn học chuyên ngành, nhu cầu của xã 
hội về ngành Chế tạo máy… Buổi giới thiệu ñã giúp 
cho các tân sinh viên có một cái nhìn tổng quan về 
ngành mình ñang học, giúp sinh viên ñịnh hướng 
nghề nghiệp và có kế hoạch cho quá trình học tập 
của mình. 

Ký 13 hợp ñồng chế tạo sản phẩm cơ khí trọng 
ñiểm 

 Vừa qua, tại Hà Nội, Hiệp hội Doanh 
nghiệp cơ khí Việt Nam (VAMI) tổ chức hội nghị 
toàn thể hội viên, ñánh giá hoạt ñộng thường niên 
và sau hai năm thành lập hiệp hội. Nguyên Tổng Bí 
thư ðỗ Mười dự và phát biểu ý kiến với hội nghị. 

 Năm nay, VAMI tiếp tục phát huy vai trò tổ 
chức liên kết hợp tác các ñơn vị cơ khí, thực hiện 
hiệu quả sản xuất sản phẩm, xây lắp công trình cơ 
khí như: ô-tô, tàu thủy trọng tải lớn, thiết bị, phụ 
tùng sản xuất xi-măng, thiết bị thủy công nhà máy 
thủy ñiện, thiết bị, vật tư ngành nước... Tại hội nghị, 

các ñơn vị cơ khí ñã ký 13 hợp ñồng hợp tác chế tạo 
sản phẩm cơ khí trọng ñiểm, tiêu biểu là các hợp 
ñồng chế tạo cẩu 180 tấn, 450 tấn, thiết bị thủy công 
nhà máy thủy ñiện, thiết bị toàn bộ nhà máy xi-
măng ðồng Bành (Lạng Sơn), nồi hơi áp lực cao... 

Theo Nhân Dân 

Thương hiệu Việt Nam sẽ trở thành hiện thực 

 Sáng 26/9, Thủ tướng Phan Văn Khải ñã cắt 
băng khánh thành, tham quan Nhà máy Ô tô 
Tracomeco tại phường Trường Thọ (quận Thủ ðức, 
TP.HCM) và chứng kiến lễ ký kết xuất khẩu lô hàng 
xe buýt ñầu tiên của Tracomeco sang nước Cộng 
hòa Dominica ở châu Mỹ La-tinh. 

 Phát biểu tại buổi lễ, Thủ tướng Phan Văn 
Khải nhấn mạnh: "Sự ra ñời của Tracomeco là ñúng 
với ñịnh hướng phát triển công nghiệp ô tô Việt 
Nam. Với một nhu cầu hết sức lớn lao hiện nay, 
chúng ta vui mừng trước sự ra ñời này và mong ước 
có những chiếc ô tô mang thương hiệu Việt Nam 
bắt ñầu trở thành hiện thực".  

 Nhà máy Ô tô Tracomeco do Công ty cổ 
phần Cơ khí - Xây dựng giao thông (Tổng công ty 
Công nghiệp ô tô Việt Nam) xây dựng rộng 
40.000m2 với kinh phí 186,722 tỉ ñồng. Hằng năm, 
nhà máy sản xuất 2.000 xe khách và 10.000 xe tải 
mang thương hiệu Trasinco. 

Trung Quốc phóng thành công vệ tinh sử dụng 
công nghệ nano 

Tên lửa Trường 

Chinh II C mang 

theo vệ tinh 

Nano I ñang 

ñược phóng lên 

quỹ ñạo. 

 Sáng 
sớm ngày 19-4, 
Trung Quốc ñã 
phóng thành 
công vệ tinh 
Nano I lên quỹ 
ñạo. ðây là vệ 
tinh ñầu tiên sử 
dụng công nghệ 
nano do Trung 

Quốc tự thiết kế. Thành công này ñã ñưa Trung 
Quốc trở thành quốc gia thứ tư trên thế giới có chế 
tạo ñược vệ tinh nano sau Nga, Mỹ và Anh. 

 Với việc phóng vệ tinh Nano I, có trọng 
lượng 25kg và ñược ðại học Thanh Hoa và Công ty 
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Công nghệ Vệ tinh Thanh Hoa hợp tác chế tạo, 
Trung Quốc ñã ñạt ñược một bước tiến quan trọng 
trong việc nghiên cứu các vệ tinh mini. 

 Các chuyên gia cho biết, việc sử dụng công 
nghệ nano cho phép vệ tinh có trọng lượng nhỏ hơn 
và có mức ñộ tích hợp thiết bị cao hơn. ðây là một 
trong những hướng ñi quan trọng nhất của ngành 
hàng không vũ trụ hiện ñại với xu hướng phát triển 
tàu vũ trụ với kích thước ngày càng nhỏ hơn. 

 Trong khi tiên ñoán các vệ tinh mini như 
một cuộc cách mạng trong lĩnh vực hàng không vũ 
trụ, các chuyên gia Trung Quốc cho biết Trung 
Quốc ñã xem xét việc phát triển các vệ tinh cực nhỏ 
như một hướng ñi quan trọng ñể phục vụ sự phát 
triển của ñất nước. 

 Trước ñó, Trung Quốc ñã thành công trong 
việc ñưa lên quỹ ñạo những vệ tinh nhỏ phục vụ 
nghiên cứu khoa học, khảo sát tài nguyên, dự báo 
các thảm họa thiên nhiên và bảo vệ môi trường. 

    Theo Tân Hoa xã 

Một kỹ sư chế tạo thành công ô-tô ñiện 

 Mới ñây, kỹ sư ðặng Thế Minh, ở 107 
ñường Giải Phóng, Hà Nội cùng các cộng sự ñã chế 
tạo thành công loại xe ô-tô ñiện chạy bằng năng 
lượng ñiện, không gây tiếng ồn, không thải khí CO2, 
góp phần giữ môi trường trong sạch.  

 Xưởng chế tạo nằm tại 52 Ngọc Lâm, Gia 
Lâm. Thực ra kỹ sư Minh mới chỉ bắt tay nghiên 
cứu chế tạo xe ô-tô ñiện từ tháng 10-2003, gặp 
không ít khó khăn ban ñầu. ðược bạn bè (cùng 
Khoa Chế tạo máy - ðại học Bách khoa Hà Nội) 
khích lệ giúp ñỡ, việc chế tạo xe ô-tô ñiện ñã cơ bản 
thành công.  

 Tháng ba tới, năm chiếc sẽ xuất xưởng. 
Kích cỡ xe gọn nhẹ như ô-tô buýt mini, có 11 chỗ 
ngồi, chạy ñược 100km cho một lần nạp ñiện (tiêu 
thụ khoảng 15kWh, tương ñương 12 nghìn ñồng), 
tốc ñộ tối ña 50km/giờ. Giá tiêu thụ nhiên liệu như 
vậy rẻ hơn nhiều so với xe ô-tô chạy xăng cùng 
trọng tải, trên xe luôn có bình ắc-quy dự trữ. 

 Kỹ sư ðặng Thế Minh cho biết, chiếc xe 
mới chế tạo có nhiều cải tiến so với xe mẫu, phụ 
tùng gần 100% nội ñịa, có thể dùng làm xe buýt chở 
khách ở ñường phố chật hẹp, có thể thay ñổi thiết kế 
làm xe phục vụ chở hàng trong cơ quan, nhà máy, 
ñưa khách tham quan ở các ñiểm du lịch, văn hóa, 
thể thao. Sự tiện dụng nhiều mặt và cơ ñộng của ô-
tô ñiện do kỹ sư ðặng Thế Minh chế tạo sẽ góp 

phần ña dạng hóa các loại hình phương tiện giao 
thông ñang rất cần thiết ở các khu ñô thị.  

Báo ðại ñoàn kết 

Một kỹ sư chế tạo máy cắt kim loại ñiều khiển 

bằng máy tính 

 Kỹ sư 
Lê Anh Kiệt, 
Công ty Chế tạo 
máy & CNC 
AKB, ñã nghiên 
cứu chế tạo 
thành công máy 
cắt kim loại 
chép hình. ðây 
là chiếc máy CNC bán tự ñộng ñược gia công hoàn 
toàn tại Việt Nam.  

 Máy có thể cắt sắt có ñộ dày từ 5 ly ñến 200 
ly theo nhiều kiểu khác nhau một cách sắc nét. Máy 
có thể cắt dò ñường (theo bản vẽ), dùng cho những 
người sản xuất vừa và nhỏ. Ngoài ra, máy còn ñược 
cài ñặt bộ vi xử lý ñể cắt theo dạng mẫu cài ñặt ở bộ 
nhớ, hoặc cắt CNC (cắt theo bản vẽ trên máy tính), 
ñược áp dụng ñể làm các chi tiết máy cho các 
xưởng cơ khí, xưởng ñóng tàu lớn. Thời gian ñể 
hoàn thành việc cắt một chi tiết máy thường mất 
khoảng một phút. 

 Kỹ sư Kiệt cùng cộng sự ñã tự viết phần 
cứng, phần mềm ñến gia công hoàn thiện máy. Giá 
thành một thiết bị là 3.500 USD, so với giá ngoại 
nhập chỉ bằng 1/5 (17.000 USD ). 

 ðược biết, máy cắt kim loại chép hình ñã 
ñược nhận huy chương vàng tại hội chợ Techmart 
tổ chức vào tháng 10 qua tại Hà Nội. Hiện kỹ sư Lê 
Anh Kiệt ñã nhận ñược rất nhiều ñơn ñặt hàng của 
các doanh nghiệp phía bắc. 

Báo Người lao ñộng 

Thiết bị xử lý nước biển thành nước ngọt ñầu 
tiên của Việt Nam 

 Thiết bị xử lý nước mặn ñầu tiên của Việt 
Nam do Trung tâm tư vấn và chuyển giao công 
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nghệ nước sạch và môi trường (CTC) nghiên cứu 
thiết kế mới ñây ñã ñược lắp ñặt thành công tại ñảo 
Bạch Long Vĩ. Với dây chuyền này, nước ngọt sản 
xuất ra có giá khoảng 20.000 ñồng/m3, chỉ bằng 1/5 
giá nước ngọt ñang bán tại ñảo. 

 Tiến sĩ ðào ðình Kim là một trong những 
nhà khoa học chủ chốt của Trung tâm tư vấn và 
chuyển giao công nghệ nước sạch và môi trường 
(CTC) nghiên cứu, thiết kế và chế tạo dây chuyền 
này theo hợp ñồng trị giá gần 2,5 tỷ ñồng với 
UBND thành phố Hải Phòng. Ông cho biết :"Công 
nghệ xử lý nước biển thành nước ngọt ñã ñược các 
nước phát triển nghiên cứu thành công từ hàng chục 
năm nay. Chìa khóa của công nghệ này là khâu tách 
các tinh thể muối rất nhỏ ra khỏi nước biển", ông 
Kim cho biết. Có nhiều cách ñể làm ñược ñiều này 
nhưng kỹ thuật thẩm thấu ngược có sử dụng màng 
lọc RO là phổ biến nhất. "Kỹ thuật này cho phép 
tách muối trong khi vẫn giữ ñược một số chất 
khoáng cần thiết ñể bảo ñảm sức khỏe cho con 
người. Hơn nữa, nó cho phép thực hiện xử lý nước 
biển ở quy mô công nghiệp". 

 Dây chuyền gồm 5 thiết bị xử lý nước biển 
qua 5 công ñoạn khác nhau với tỷ lệ nội ñịa hóa 
70%. Nước biển ñược bơm qua thiết bị ñầu tiên sẽ 
ñược lọc sạch rong, rêu, tảo bằng một màng lọc có 
kích thước lỗ 50 micrometres. Sau ñó, thiết bị lọc 
"vạn năng" (Multimedia) sẽ lọc sạch các chất có 
kích thước lớn hơn 20 micrometres. Sang thiết bị 
thứ ba, Ca, Mg, Br... ñược loại ra khỏi nước biển 
dưới dạng muối carbonat bằng phương pháp trao 
ñổi cation. Thiết bị lọc thứ tư tiếp tục loại các chất 
có kích thước lớn hơn 5 micrometres ra khỏi nước 
biển. Và ñến thiết bị cuối cùng sử dụng màng lọc 
RO có kết cấu ñặc biệt. Quá trình thẩm thấu ngược 
diễn ra tại ñây khi nước biển (sau khi ñã qua các 
công ñoạn tiền xử lý trước ñó) ñược bơm áp suất 
cao tới 70 asmosphere qua hệ thống màng lọc này. 
Kết thúc quá trình thẩm thấu ngược, người ta sẽ thu 
ñược một lượng nước ngọt bằng 36% lượng nước 
biển lọc qua dây chuyền. 

 Kết quả phân tích hóa học nước qua xử lý 
trên dây chuyền của Viện y học lao ñộng và vệ sinh 
môi trường của Bộ Y tế cho thấy, nước ñạt ñộ tinh 
khiết cao, có thể dùng uống trực tiếp. Trong khi ñó 
giá thành dây chuyền rẻ chỉ bằng 1/2 so với loại 
cùng công suất nhập ngoại. Với dây chuyền này, 
nước ngọt sản xuất ra có giá khoảng 20.000 
ñồng/m3 gồm cả chi phí vận hành và khấu hao dây 
chuyền trong 8 năm). Giá thành này chỉ bằng 1/5 so 
với giá nước ngọt bán kinh doanh cho các tàu ñánh 
cá ở Bạch Long Vĩ hiện nay; Theo ông Kim, cái giá 

này có thể giảm xuống ñáng kể nếu dây chuyền 
ñược lắp ñặt ñể xử lý nước lợ hay ñược chế tạo với 
công suất lớn hơn ñể xử lý nước mặn ở các vùng 
ven biển... 

Thời báo kinh tế Việt Nam 

Honda/IBM cải tiến hệ thống nhận biết lời nói 

 Hãng xe hơi Honda cùng với sự góp sức 
bằng phần mềm của hãng IBM, ñang chuẩn bị tung 
ra lọai hệ thống nhận biết tiếng nói làm thiết bị tiêu 
chuẩn cho loại xe hơi 2005 Acura RL.  

 Hãng Honda cho biết tài xế sẽ không cần 
dùng tay ñể bấm nút  xem thông tin hoặc rời mắt 
nhìn ñường ñể liếc màn hình vi tính, nhưng sẽ nghe 
tiếng nói hướng dẫn ñường ñi từ hệ thống nói trên.  

 Hơn 1,7 triệu tên ñường và tên thành phố 
tại nước Mỹ ñại lục ñược  lưu vào hệ thống. Hệ 
thống này cũng cho phép những hướng dẫn có thể 
nghe ñựơc – và thậm chí nhìn thấy – các khách sạn 
gần tới, và các khả năng ñiều khiển-và-kiểm sóat 
ñối với cường ñộ âm thanh, nhiệt ñộ và các chức 
năng khác.  

 So với nguyên mẫu, hệ thống mới có khả 
năng phát tiếng nói của người, ñưa ra những câu trả 
lời có âm thanh tự nhiên, và ñáp ứng lại hàng trăm 
lệnh khác. 

Theo Tuổi Trẻ 

Nhật chế tạo Robot bảo vệ 

 Hãng an ninh Nhật Secom Co. ñã giới thiệu 
lọai robot mới tên Secom Robot X có khả năng xua 
ñuổi những kẻ ñột nhập với tốc ñộ di chuyển 
10km/g.  

 Hãng Secom hi vọng sử dụng Secom Robot 
X trong hệ thống bảo vệ an ninh cho các công ty xí 
nghiệp, phi trường,  hải cảng, bãi ñậu xe và những 
khu vực rộng lớn khác. Robot này có các bộ cảm 
biến hồng ngoại có thể tiếp xúc với nhân viên bảo 
vệ khi nó phát hiện những kẻ ñột nhập. Ngòai ra nó 
còn có thể xịt khói vào kẻ trộm hoặc kẻ ñột nhập. 

 Hãng Secom hi vọng sẽ tung ra thị trường 
Robot X vào ñầu năm 2005.  

Robot Thái Lan sẽ thám hiểm Nam cực 

 Một toán nghiên cứu Thái Lan ñã thử 
nghiệm thành công robot hoạt ñộng dưới nước ñược 
ñiều khiển từ xa tại hồ bơi ðại học Mahidol 
(Bangkok), nhằm chuẩn bị cho chuyến thám hiểm 
Nam cực của robot vào cuối năm nay.  
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 Robot mang tên ThaiXPole, chạy bằng năng 
lượng mặt trời, ñược thiết kế ñặc biệt ñể chịu ñựng 
các ñiều kiện thời tiết ở Nam cực, chẳng hạn chịu 
ñựng nhiệt ñộ tới -40OC, hạn mức mà các robot 
khác chưa ñạt ñược. Nó lặn sâu ñến 50m và có các 
dụng cụ ño ñộ mặn, tốc ñộ nước, nhiệt ñộ, ñộ pH và 
mức oxy.  

Xe hơi hydro nhanh nhất thế giới 

 Hãng chế 
tạo xe hơi hạng 
sang BMW của 
ðức ñã giới thiệu 
lọai xe hơi nhanh 
nhất thế giới chạy 
bằng khí hydro 
tại cuộc triển lãm 
xe hơi ở Paris 
(Pháp) ngày 22-9, 
ñược ñặt tên là H2R, có khả năng chạy với vận tốc 
300km/g.   

 Burkhard Goeschel, thành viên bạn quản trị 
BMW và là người phụ trách kỹ thuật của hãng, nói 
xe hơi H2R có dạng tên lửa, có thể tăng tốc ñộ từ 0 
ñến 100km/g trong vòng sáu giây và ñạt ñến tốc ñộ 
tối ña là 302,4 km/g trên xa lộ thử nghiệm của 
BMW ở Miramas, Pháp. Goeschel nói thêm:”Xe 
hơi tên là H2R – ‘R’ có nghĩa là kỷ lục (record)”,  
rõ ràng hãnh diện về kỳ công trong lãnh vực khói 
thải bằng 0.  

 Không giống như phần lớn các xe hơi hydro 
khác, H2R không họat ñộng bằng pin mà bằng ñộng 
cơ ñốt trong 6 lít, 12 xylanh tạo lực ñẩy và chủ yếu 
không tạo ra khí thải ngoại trừ hơi nước mà thôi. 
Ngòai ra BMW cho biết việc hỗn hợp không khí-
hydro ñược ñốt dưới sức ép cao mang lại mức hiệu 
quả cao hơn.  

Bộ ñiều khiển thông minh cho ñộng cơ xăng 

 

 

 

 

 

Bộ ñiều khiển ECU 

và phần mềm ECCom. 

 Thạc sĩ Trần Anh Trung cùng các cộng sự 
của bộ môn ñộng cơ ñốt trong, Khoa cơ khí, Trường 
ñại học Bách khoa ñã chế tạo thành công bộ ñiều 

khiển tự ñộng (ECU) giúp tránh tình trạng lãng phí 
nhiên liệu, tăng tuổi thọ ñộng cơ, giảm phát thải khí 
gây ô nhiễm. 

Bộ ñiều khiển này ñược nhóm nghiên cứu chế tạo 
thành công vào cuối năm 2001 ñể thay thế cho chiếc 
xe hiệu Audi của ðức. Thành công này thúc ñẩy 
nhóm nghiên cứu triển khai việc phát triển sản 
phẩm ECU cho mọi loại ñộng cơ ô-tô. Sở dĩ nhóm 
nhắm vào việc nghiên cứu sản xuất ECU vì ñây 
ñược coi như "trái tim" của việc hệ thống ñiều 
khiển. ECU chính là bộ vi xử lý ñiều khiển số, nó 
cho phép kết nối giữa hệ thống nhiên liệu và hệ 
thống ñánh lửa. 

Hiện nay, hầu hết các loại xe ô-tô ở Việt Nam ñều 
nhập ngoại và ñể cạnh tranh, tạo sự ñộc quyền, các 
hãng sản xuất xe chỉ sản xuất riêng loại ñiều khiển 
ñộng cơ phun xăng cho chủng xe của mình. Vì vậy, 
khi có hỏng hóc xảy ra, rất khó kiếm phụ tùng thay 
thế, thậm chí không có. Nếu muốn thay thế mới, 
phải chờ ñợi ñặt hàng từ chính hãng với ñiều kiện 
hãng còn sản phẩm phụ kiện này và người tiêu dùng 
thường phải mua với giá rất ñắt (từ 1.500 ñến 4.000 
USD một hộp ñiều khiển ECU). 

 Với bộ ECU "Made in Việt Nam", lượng 
xăng phun ñược tính toán chính xác bằng máy tính 
dựa trên các cảm biến nhiệt ñộ ñộng cơ, nhiệt ñộ khí 
nạp, tốc ñộ... Chính vì vậy lượng xăng sẽ ñược sử 
dụng tối ña bởi trong thời gian chạy ấm máy, lượng 
nhiên liệu ñược tính toán chính xác và góc ñánh lửa 
ñược ñiều chỉnh hợp lý. Lượng nhiên liệu tiêu thụ 
cũng giảm ñáng kể bởi hệ thống phun nhiên liệu sẽ 
cắt phun khi xe xuống dốc và giảm phần nào nhờ sự 
thu hồi nhiên liệu khi ngừng phun hoặc tắt máy. 
Bên cạnh ñó, chế ñộ khởi ñộng cũng hoàn hảo hơn 
nhờ sự tính toán chính xác lượng nhiên liệu phun 
trong thời kỳ này. Không những vậy một lợi ích xã 
hội có thể thấy rõ là hàm lượng chất ñộc trong khí 
xả giảm ñáng kể do nhiên liệu sử dụng ñược tối ña. 

 Thạc sĩ Trần Anh Trung cho biết bộ ñiều 
khiển ECU vẫn ñang tiếp tục ñược nâng cấp và sẵn 
sàng ñáp ứng yêu cầu của khách hàng. Sản phẩm ñã 
hoàn thiện, với mỗi loại xe riêng chỉ cần giữ nguyên 
phần cứng, thay ñổi phầm mềm cho phù hợp là có 
thể lắp ñặt ñược ngay. Tuy nhiên, nếu lắp ñặt riêng 
cho một xe thì giá thành khá cao, khoảng 20 triệu 
ñồng/bộ do chi phí chạy thử nghiệm trên băng tải, 
trên ñường ñể tìm ra số liệu phù hợp. Song từ kết 
quả thử nghiệm này, nếu ñược sản xuất ñại trà thì 
giá bán sản phẩm sẽ rẻ ñi rất nhiều. 

Theo Thời báo kinh tế Việt Nam 
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YẾU TỐ NÀO NÂNG CAO CHẤT LƯỢNG GIÁO DỤC ðẠI HỌC VIỆT NAM 

 Ngày 5/11, ðH Sư phạm TP Hồ Chí Minh, 

Báo Giáo dục và Thời ñại ñã tổ chức hội thảo khoa 

học “Các giải pháp cơ bản nâng cao chất lượng giáo 

dục ñại học”, quy tụ trên 40 tham luận của các 

chuyên gia giáo dục, nhà khoa học, quản lý giáo dục 

và cán bộ giảng dạy các trường ñại học trong, ngoài 

nước. 

 Hầu hết những giải pháp ñưa ra ñể nâng cao 

chất lượng ñào tạo bậc ñại học ñều nhấn mạnh ñến 

yếu tố quan trọng nhất: con người. 

 Chương trình ñào tạo ngày càng xa... 
chuẩn thế giới? 

 Theo nhiều ñại biểu tham gia hội thảo, hiện 

chương trình ñào tạo của ñại học Việt Nam là có vấn 

ñề, nhiều bất cập và thực tế chưa ñược các nước thừa 

nhận! GS, TSKH ðỗ Trần Cát, Tổng thư ký Hội 

ñồng học hàm nhà nước, thừa nhận một thực tế: 

"Trong các thập kỷ 70, 80 của thế kỷ trước, người 

Việt Nam ñi học nghiên cứu sinh ở nước ngoài chỉ 
cần có bằng ñại học. Sang ñến thập kỷ 90, khi chúng 

ta coi cao học là sau ñại học, các nước yêu cầu người 

Việt Nam học nghiên cứu sinh phải có bằng thạc sĩ. 
Nhưng sang thế kỷ 21, một số nước phát triển ñã bắt 

ñầu không công nhận thạc sĩ của Việt Nam mà bắt 

các nghiên cứu sinh của ta phải thi lấy bằng thạc sĩ 
của họ sau ñó mới nhận làm nghiên cứu sinh, dù 

những người này ñã có bằng thạc sĩ của Việt Nam".  

 Thực tế, hiện ở Việt Nam bậc ñại học chỉ là 

dạy nhiều môn của cao ñẳng, cao học thì dạy nhiều 

môn của ñại học vì thế về trình ñộ khó khẳng ñịnh 

thạc sĩ cao hơn cử nhân hay kỹ sư một bậc. Chính 

việc ñể cao học tách khỏi ñại học khiến chương trình 

ñào tạo ñại học ở Việt Nam có khuynh hướng "nâng 

lên một bậc": trung học chuyên nghiệp thành cao 

ñẳng, cao ñẳng thành ñại học, ñại học thành sau ñại 

học. ðây cũng là lý do tất cả các bậc học ñều có vấn 

ñề về chất lượng! Về vấn ñề này, ông ðỗ Trần Cát 

ñã ñưa ra một ñề nghị cụ thể: "Bộ nên soạn thảo một 

chương trình duy nhất ñối với mỗi môn học chung 

cho 3 mức học: cao ñẳng, cử nhân, kỹ sư, bác sĩ - 

dược sĩ (hoặc cao học) sao cho chương trình của 3 

mức này không lặp lại: học 3 năm cấp bằng cao 

ñẳng, thêm 1 năm với chương trình bổ sung ñược 

cấp bằng cử nhân, học thêm 1-2 năm nữa với 

chương trình bổ sung ñược cấp bằng kỹ sư hoặc thạc 

sĩ. Sau ñại học chỉ nên là nghiên cứu sinh".  

 Giảm quy mô có tăng chất lượng? 

 ðể ñảm bảo chất lượng, có ý kiến cho rằng 

không ñược tăng số lượng, tức phải giảm quy mô 

ñào tạo hiện nay! GS, TSKH Lâm Quang Thiệp, 

ðH Quốc gia Hà Nội, cho rằng: "Quả thật số lượng 

sinh viên nước ta tăng nhanh nhưng vẫn chưa ñủ 

nếu muốn công nghiệp hóa, hiện ñại hóa. Hơn nữa 

không phải giảm số lượng thì mặc nhiên có chất 

lượng". ðể giải quyết bài toán số lượng-chất 

lượng, theo ông Thiệp "cần phải phân luồng học 

sinh ngay từ bậc học thấp bằng cách quy hoạch 

một hệ thống trường dạy nghề thích hợp ñể giảm 

lưu lượng dòng học sinh vào ñại học". Ở bậc ñại 

học, theo ñề nghị của ông Thiệp, cần phân thành 2 

dòng chính: Trường ñại học truyền thống với các 

loại hình ñào tạo chính quy, ñòi hỏi cao về chất 

lượng ñầu vào và hạn chế số lượng; Các trường ñại 

học mở, không cần ñòi hỏi cao về chất lượng ñầu 

vào và cũng không hạn chế số lượng.  

 Cán bộ giảng dạy: thiếu, yếu. 

 Phần lớn các ñại biểu tham gia hội thảo ñều 

thừa nhận yếu tố quan trọng nhất ñể nâng cao chất 

lượng ñào tạo là phải có người thầy giỏi nhưng 

thực tế hiện nay lực lượng này "thiếu về số lượng, 

yếu về chất lượng". Theo nghiên cứu của PGS, TS 

Nguyễn Kim Hồng - Phó hiệu trưởng trường ðH 

Sư phạm TP Hồ Chí Minh, nhiều trường ñại học, 

số cán bộ giảng dạy có trình ñộ tiến sĩ chỉ khoảng 

10-25%, trong ñó có nhiều người không còn khả 

năng nâng cao hơn nữa học vấn và gặp nhiều khó 

khăn về ngoại ngữ". GS, TS Lê Ngọc Trà - Viện 

trưởng viện Nghiên cứu giáo dục trường ðH Sư 

phạm TP Hồ Chí Minh - hết sức thẳng thắn khi 

thừa nhận: "Nhiều năm qua những người ñược giữ 

lại trường làm cán bộ giảng dạy có thật sự giỏi 

không?". Theo hướng này, ông ñề xuất 2 cách 

chọn thầy giỏi: Chọn những sinh viên có khả năng 

nghiên cứu khoa học, sáng tạo chứ không phải sinh 

viên ñạt ñiểm cao, ngoan ngoãn. Không nên chỉ 
giữ sinh viên ở khoa mình, trường mình làm cán 

bộ giảng dạy vì có nguy cơ lập lại thầy mình. PGS, 

TS lương Ngọc Toản - nguyên thứ trưởng Bộ GD-

ðT - cho rằng "phải có ngay quy hoạch xây dựng 

ñội ngũ cán bộ giảng dạy cho các trường ñại học, 

ñặc biệt phải có chế ñộ ñãi ngộ thỏa ñáng". Theo 

dự báo, ñến năm 2012, số sinh viên/vạn dân của 

Việt Nam sẽ ñạt mức như Thái Lan hiện nay. ðể 

ñảm bảo chất lượng ñào tạo, số giảng viên cần có 

là 109.620 người (so với 33.400 hiện nay). Theo 

ông Nguyễn Kim Hồng: "ðây là một tốc ñộ tăng 

trưởng mà nếu không có sự can thiệp mạnh tay của 

Nhà nước thì không thể" !  

Báo Thanh Niên 
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Phát triển công nghệ tự ñộng hoá 

 Công nghệ tự ñộng hóa có vai trò hết sức 
quan trọng trong sự nghiệp công nghiệp hóa 
(CNH) hiện ñại hóa (HðH) ñất nước. Tự ñộng 
hóa là một trong những yếu tố quyết ñịnh việc 
nâng cao năng suất, chất lượng và hạ giá thành 
sản phẩm, góp phần tạo nhiều sản phẩm có chất 
lượng cao, có sức cạnh tranh trên thị trường. 

 Ở Việt Nam công nghệ tự ñộng hóa ñang 

ngày càng chiếm một vai trò rất quan trọng. ðội ngũ 

cán bộ khoa học kỹ thuật ngày càng nâng cao tay 

nghề, nắm vững và làm chủ nhiều công nghệ tự 

ñộng hóa hiện ñại. Nhiều sản phẩm của Việt Nam 

chế tạo ñã ñạt ñược chỉ tiêu kỹ thuât tương ñương 

với các sản phẩm của các nước tiên tiến, với giá 

thành thấp hơn nhiều so với nhập ngoại. Có những 

sản phẩm ñã giành ñược tín nhiệm của thị trường, 

ñược áp dụng rộng rãi, tiết kiệm ngoại tệ cho Nhà 

nước và các cơ sở sản xuất. Chẳng hạn như hệ thống 

ño lường ñiều khiển trộn bê-tông nhựa át phan, ñã 

ñẩy lùi hoàn toàn các thiết bị nhập ngoại, do giá 

thành chỉ bằng 20-40% mà chất lượng và tính năng 

không hề thua kém hàng của các nước tiên tiến như 

như ðức, Anh... Sản phẩm này hiện nay ñã chiếm 

lĩnh 100% thị phần trong nước, ñẩy lùi hoàn toàn 

thiết bị nhập ngoại, tiết kiệm cho ñất nước mỗi năm 

40 triệu USD. 

 Tự ñộng hóa cũng ñã ñem lại nhiều hiệu quả 

trong việc tăng năng lực sản xuất. Chẳng hạn, dây 

chuyền tự ñộng hóa sản xuất phân NPK ở nhà máy 

Supe phốt phát hóa chất Lâm Thao, ñã ñưa năng suất 

lên gấp ñôi, giải phóng gần 300 lao ñộng. ðây là dây 

chuyền sản xuất NPK hiện ñại nhất Việt Nam, hoàn 

toàn do chúng ta nghiên cứu thiết kế, chế tạo. Giá 

thành sản phẩm chỉ bằng 30% so với nhập khẩu. 

Hiện nay chương trình khoa học công nghệ tự ñộng 

hóa ñang mở rộng ứng dụng rôbốt thông qua hai ñề 

tài nghiên cứu khoa học cấp nhà nước. 

 Việc ứng dụng tự ñộng hóa của rất nhiều cơ 

quan nghiên cứu, các trường ñại học và cơ sở sản 

xuất cũng ñã dem lại những kết quả khả quan. Ví 

như hệ thống tự ñộng sản xuất bia, sản xuất thức ăn 

gia súc, xử lý rác thải, các hệ giám sát môi trường, 

các hệ SCADA trong ngành ñiện lực, dầu khí... 

Những kết quả này ñã góp phần làm tăng trưởng nền 

kinh tế nước ta trong những năm vừa qua.  

 Hiện nay vấn ñề ñào tạo ñội ngũ các bộ khoa 

học cho tương lai về lĩnh vực tự ñộng hóa ñang trở 

nên ngày càng gần gũi với mọi người-từ các nhà 

nghiên cứu, các nhà giáo, nhà quản lý, nhà công 

nghiệp ñến cả học sinh và sinh viên. Giải nhất 

cuộc thi rôbốt quốc tế tại Nhật Bản vừa qua của 

sinh viên thành phố Hồ Chí Minh ñã chứng minh 

ñiều này. 

 Mục tiệu của ngành khoa học tự ñộng hoá ở 

Việt Nam là hướng tới tập trung tự nghiên cứu và 

thiết kế các hệ thống tự ñộng hoá lớn thay thế cho 

nhập ngoại. Sẽ ứng dụng tự ñộng hóa vào một số 

ngành sản xuất quan trọng, trực tiếp liên quan ñến 

xuất khẩu như ngành nuôi trồng và chế biến thuỷ 

sản, chế biến thực phẩm, các ngành công nghiệp 

nhẹ (như may mặc, giày da), ngành chế tạo máy, 

bảo vệ môi trường. Xúc tiến ứng dụng tự ñộng hóa 

vào những ngành quan trọng như dầu khí, ñiện lực, 

bưu chính viễn thông, cơ khí chế tạo... tiến tới sản 

xuất ñược một số cấu kiện ñiện tử quan trọng. ðây 

sẽ là cơ sở phục vụ cho sự phát triển tự ñộng hóa 

một cách tự chủ và bền vững. Việc tiếp cận với 

những công nghệ tiên tiến của thế giới về tự ñộng 

hóa ñể chuyển giao công nghệ và hội nhập có hiệu 

quả như tự ñộng hóa tích hợp, các thế hệ rôbốt, các 

hệ SCADA diện rộng... cũng rất cần thiết. ðặc 

biệt, cần kết hợp nhuẫn nhuyễn giữa các ngành 

công nghệ cao như ñiện tử, tin học, tự ñộng hóa 

viễn thông... chắc chắn Việt Nam sẽ tạo ra các sản 

phẩn có hàm lượng chất xám cao và ña dạng trong 

thời gian tới.  

Theo báo QðND 

 

Rôbốt hàn 

 
Robot vạn năng cấp phôi 

cho máy tôi cao tầng. 
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DANH MỤC CÁC DỰ ÁN SXTN ðỘC LẬP CẤP NHÀ NƯỚC  
ðỂ TUYỂN CHỌN THỰC HIỆN TRONG KẾ HOẠCH NĂM 2004 

1. Tên Dự án : Chế tạo lò ñốt chất thải y tế cho các bệnh viện cấp huyện. 

  Mục tiêu : Hoàn thiện công nghệ chế tạo lò ñốt chất thải y tế có xử lý khí thải bằng phương pháp hấp 
phụ ñạt theo tiêu chuẩn chất lượng hiện hành cho các bệnh viện cấp huyện. 

  Dự kiến sản phẩm :  

  - Qui trình chế tạo (kèm theo Bản vẽ thiết kế) hệ thống lò ñốt chất thải y tế công suất 10-20 Kg/giờ; 

  - Lò ñốt chất thải y tế công suất 10-20 Kg/giờ với các thông số ñạt tiêu chuẩn hiện hành theo yêu cầu kỹ 
thuật cơ bản và tiêu chuẩn khí thải của Lò ñốt chất thải y tế; Vận hành ñơn giản và an toàn; Xuất ñầu tư và chi 
phí vận hành hợp lý ñược các bệnh viện cấp huyện chấp nhận sử dụng. 

2. Tên Dự án : Chế tạo công tơ mẫu và các thiết bị kiểm ñịnh công tơ một pha và ba pha, cấp chính xác 0,1. 

 Mục tiêu : Hoàn thiện công nghệ và chế tạo thiết bị chuẩn dùng ñể kiểm ñịnh các loại công tơ ñiện xoay 
chiều, cấp chính xác 0,1. 

  Dự kiến sản phẩm :  

  - Bộ quy trình thiết kế và công nghệ chế tạo công tơ mẫu và thiết bị kiểm ñịnh công tơ một pha và ba pha 
cấp chính xác 0,1; 

 - Một số sản phẩm sau: 

 + Công tơ mẫu một pha và ba pha cấp chính xác 0,1; 

 + Thiết bị chuẩn dùng ñể kiểm ñịnh công tơ một pha cơ, ñiện tử; 

 + Thiết bị chuẩn dùng ñể kiểm ñịnh công tơ ba pha cơ, ñiện tử; 

 + Thiết bị chuẩn cơ ñộng dùng ñể kiểm ñịnh công tơ một pha cơ, ñiện tử; 

 Các loại sản phẩm trên phải ñảm bảo chất lượng và giá thành cạnh tranh với sản phẩm nhập khẩu cùng 
loại. 

3. Tên Dự án : Xây dựng và áp dụng thử nghiệm một dây chuyền tuyển than trong bã sàng cho các mỏ than 
vùng Quảng Ninh bằng công nghệ huyền phù kiểu tang quay. 

 Mục tiêu : Hoàn thiện công nghệ tuyển than trong bã sàng bằng công nghệ huyền phù kiểu tang quay 
nhằm tận thu than và giảm thiểu ô nhiễm môi trường. 

 Dự kiến sản phẩm :  

  - Bộ tài liệu hồ sơ thiết kế dây chuyền thiết bị, quy trình công nghệ sản xuất; 

  - Một dây chuyền thiết bị tuyển than trong bã sàng bằng công nghệ tuyển huyền phù kiểu tang quay với 
yêu cầu kỹ thuật: Công suất  một năm 100.000 tấn bã sàng có ñộ tro <65% ; tỷ lệ sản phẩm thu hoạch 30% ( than 
cục 10%, than cám 20% ) ; hiệu suất tuyển >95%. Chất lượng than sau tuyển ñảm bảo tiêu chuẩn. 

4. Tên Dự án : Hoàn thiện công nghệ thiết kế, thi công thảm sét ñịa kỹ thuật chống thấm trong công trình xây 
dựng, giao thông và thuỷ lợi. 

 Mục tiêu : Hoàn thiện ñược công nghệ thiết kế và thi công thảm sét ñịa kỹ thuật chống thấm các công 
trình xây dựng, giao thông và thuỷ lợi ở các tỉnh miền Trung và Nam Bộ, trên cơ sở ñó mở rộng áp dụng cho các 
vùng có ñiều kiện tương tự. 

 Dự kiến sản phẩm :  

 - Quy trình thiết kế và thi công thảm sét ñịa kỹ thuật cho các công trình xây dựng, giao thông và thuỷ lợi 
các tỉnh miền Trung và Nam bộ; 
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 - Áp dụng thử 20.000 m2 thảm sét ñịa kỹ thuật chống thấm cho 1-2 công trình tại các công trình trọng 
ñiểm miền Trung và Nam Bộ. 

5. Tên Dự án : Hoàn thiện công nghệ thiết kế, chế tạo và thi công quản lý vận hành ñập xà lan di ñộng áp dụng 
cho vùng triều  phục vụ các công trình ngăn sông vùng ven biển 

 Mục tiêu : Hoàn thiện ñược công nghệ thiết kế thi công và quản lý vận hành các kiểu ñập xà lan di ñộng 
phục vụ phát triển kinh tế xã hội vùng ven biển. 

 Dự kiến sản phẩm :  

 - Quy trình thiết kế, chế tạo, thi công và quản lý vận hành các kiểu ñập xà lan di ñộng; 

 - Các chỉ tiêu kinh tế - kỹ thuật cụ thể; 

 -Áp dụng vật liệu và kết cấu tiên tiến ñể chế tạo các kiểu ñập trên; 

 - Chế tạo và thi công thử nghiệm 2 kiểu ñập xà lan tại vùng ven biển. 

6. Tên Dự án : Hoàn thiện công nghệ sản xuất các chế phẩm sinh học và tổ hợp ña vi lượng hoạt lực cao ñể sản 
xuất  phân bón cho vùng phèn mặn ở ðồng bằng sông Cửu Long. 

 Mục tiêu : Hoàn thiện qui trình công nghệ, xác lập các thông số khoa học và ñiều kiện thực tiễn;  hình 
thành các "modun" sản xuất các chế phẩm sinh học (vi sinh, vi lượng) hoạt lực cao làm cơ sở ñể phát triển các 
nhà máy sản xuất phân bón hữu cơ vi sinh và phân bón lá ña vi lượng ở ðBSCL bằng phương pháp sinh hoá 
hiện ñaị. 

 Dự kiến sản phẩm :  

 1. Các qui trình công nghệ sản xuất phân bón hữu cơ : 

 - Qui trình sản xuất bộ giống 6 dòng vi sinh vật (Hud-1 ñến Hud - 6) có hoạt lực cao; 

 - Qui trình tạo phức hữu cơ ñối với các nguyên tố ña vi lượng, trung lượng, vi lượng và siêu vi lượng; 

 - Qui trình sản xuất phân bón hữu cơ vi sinh - ña vi lượng, công suất  10.000 - 15.000 tấn/năm từ các chế 
phẩm, ñạt TCVN; 

 - Qui trình sản xuất phân bón lá ña vi lượng chất lượng cao, công suất 40.000 - 50.000 lít/năm từ các chế 
phẩm, ñạt TCVN. 

 2.  Mô hình trình diễn (2 -3 mô hình). 

 3.  Sản phẩm : 

 - 50.000 tấn sản phẩm phân hữu cơ vi sinh chất lượng cao; 

 - 200.000 lít phân bón lá ña vi lượng hoạt lực cao; 

 - Dây chuyền thiết bị và công nghệ (ñể chuyển giao cho 2-3 cơ sở sản xuất phân bón). 

Nguyễn Văn Tường (Tổng hợp) 
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CÔNG NGHỆ CẮT BẰNG TIA NƯỚC  

 1. Nguyên lý gia công. 

  Cắt bằng tia nước (Water Jet Cutting-WJC) là một quá trình sử dụng tia nước ở áp suất cao ñể gia công 
vật liệu. Vết cắt hoặc rãnh có  ñộ rộng xấp xỉ 1mm. ðường kính lỗ nhỏ nhất có thể cắt ñược là 1,5mm. Phương 
pháp này còn ñược gọi là gia công bằng thuỷ ñộng lực học. Sơ ñồ nguyên lý ñược  thể hiện trên hình 1. 

 

 

 

 

 

 

 

 

 

 

 

  ðầu tiên nước từ thùng cấp nước ñi qua bộ lọc và hòa trộn. Sau ñó nhờ ống dẫn chất lỏng ñi qua bộ 
khuyếch ñại ñể tăng áp ñến ñầu phun. Tại ñầu phun tia nước ñược phun ra mạnh hay yếu là nhờ van tiết lưu. Van 
này ñược ñiều khiển bởi một bộ ñiều khiển. Tia nước sau khi ra khỏi ñầu phun có áp suất rất lớn (thường từ 100 
÷ 400 MPa), tốc ñộ tia nước từ 400 ÷ 1000m/s. Với áp suất này, khi tia nước chạm vào bề mặt vật liệu gia công 
nó tạo nên áp lực lớn hơn ñộ bền nén của vật liệu, bề mặt vật liệu bị nát ra và tia nước xuyên qua tạo thành vết 
cắt, cắt chi tiết gia công. Vậy tia nước tạo ñóng vai trò như một cái cưa cắt một vết hẹp trên vật liệu. 

2. Các thông số công nghệ. 

  Các thông số gia công quan trọng trong gia công bằng tia nước bao gồm : khoảng cách gia công, ñường 
kính lỗ vòi phun, áp suất nước và tốc ñộ cắt. Khoảng cách gia công là khoảng cách giữa ñầu vòi phun và bề mặt 
gia công. Thông thường khoảng cách này là nhỏ ñể tia nước phân tán tới mức tối thiểu trước khi kịp ñập vào bề 
mặt. 

  Khoảng cách gia công ñiển hình là 3,2mm. Kích thước của lỗ vòi phun ảnh hưởng ñến ñộ chính xác của 
quá trình cắt lỗ vòi. Vòi phun nhỏ ñược sử dụng trên những vật liệu mỏng. ðối với những vật liệu dày hơn thì 
cần có những tia phun dày hơn và áp suất cao hơn. Tốc ñộ cắt thường vào khoảng từ 5 ÷ 500 mm/s tùy theo ñộ 
dày của chi tiết gia công. Phương pháp gia công tia nước thường ñược tự ñộng hoá bằng hệ thống CNC hay 
người máy công nghiệp. Phạm vi gia công : từ 1,6 ÷ 305 mm với ñộ chính xác là ± 0,13 mm. 

Bảng 1 Chiều dày cắt  và tốc ñộ ăn dao khi cắt  bằng tia nước. 
Vật liệu Chiều dày cắt, mm Tốc ñộ ăn dao, m/ph 
Da 2,2 20 
Nhựa PVC 3 0,5 
Nhựa PS 2 150 
Kevlar 3 3 
Graphit 2,3 5 
Tấm thạch cao 10 6 
Tấm carton gợn sóng 7 200 
Tấm giấy bột 2 120 
Gỗ dán 6 1 

 
Chi tiết gia công 

 

 
Máng hứng nước 

 

Bộ tích 
trữ 

ðiều 
khiển 

 
Vòi phun 

 Bộ phận 
tăng áp 

Thùng cấp 
nước 

Bộ trộn và  
lọc 

Van tiết lưu 

 

 

 

 

 
 

Hình 1.  Sơ ñồ nguyên lý gia công bằng tia nước. 
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3.  Ưu ñiểm và phạm vi ứng dụng. 

  Ưu ñiểm : 

- Chất lượng vết cắt rất cao. 

- Vết cắt có thể bắt ñầu ở bất kỳ chỗ nào mà không cần khoan mồi trước và có thể cắt ñược các vật liệu 
cán mỏng. 

- Có khả năng tự ñộng hóa và người máy hóa rất cao. 

- Chí phí thấp. 

- Không có chất hóa học như  cắt bằng hạt mài (AWJC). 

- Thích ứng với hệ thống CAD/CAM. 

-  Gia công ñạt ñộ chính xác cao, bề mặt phẳng. 

- Không ảnh hưởng nhiệt. 

- Có thể cắt bất cứ vật liệu nào. 

- Ít lãng phí chất thải sau gia công. 

- Môi trường gia công trong sạch. 

Phạm vi ứng dụng. 

  - Gia công cắt : phương pháp gia công bằng tia nước ñược ứng dụng trong các ngành hàng không, thực 
phẩm, nghệ thuật ñồ họa, công nghiệp ôtô, giày dép, cao su, nhựa, ñồ chơi, gỗ, luyện kim, giấy, chế tạo máy… 

  - Làm sạch bề mặt trong ngành xây dựng và chế tạo máy. 

Một số vật liệu ñược cắt bằng tia nước là : các tông, thảm, lie (làm nút chai), giấy, plastic, sản phẩm gỗ, 
cao su, da, giấy, lá kim loại mỏng,  gạch, vật liệu composite… Tùy loại vật liệu mà chiều dày cắt lên ñến 25mm 
và cao hơn. So với các phương pháp khác, cắt bằng tia nước có năng suất cao và sạch, nên nó cũng ñược dùng 
trong công nghệ thực phẩm ñể cắt và thái mỏng sản phẩm. Khi ñó người ta sử dụng dung dịch chất lỏng là cồn, 
glyxêrin hoặc dầu ăn. 

 

 

 

 

 

 

 

          

Nguyễn Văn Tường 
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THIẾT BỊ GIA CÔNG BẰNG TIA NƯỚC 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 1.  Sơ ñồ cấu trúc các phần tử của hệ thống máy gia công bằng tia nước. 

 Máy gia công bằng tia nước có hai thành phần thiết yếu. Bàn XYZ có thể di chuyển ñầu cắt 
trên vật liệu và một máy bơm áp suất cao 400MPa. Ơ áp suất này, tia nước có thể cắt nhựa, gỗ, vật 
liệu lót sàn ñàn hồi, cao su và các chất tương tự khác.  

 ðầu cắt là một vòi có kích thước miệng vòi là 6,35mm (1/4”) bằng tinh thể sapphire mà nước 
có thể ñi qua khi chịu một áp lực bằng ba lần vận tốc của âm thanh do máy bơm áp suất cao tạo 
thành. Sự di chuyển của ñầu vòi chịu ảnh hưởng bởi chương trình cài ñặt trong máy vi tính (theo bản 
vẽ của khách hàng).  

 Khi khách hàng ñưa ra một bản vẽ, nó sẽ ñược số hoá và vẽ lại bằng phần mềm  CAD/CAM. 
Sau ñó bản vẽ ñược chuyển ñổi thành ngôn ngữ mà máy gia công bằng tia nước có thể ñọc ñược 
qua một chương trình ñược gọi là gia công nhờ máy tính CAM (Computer Aided Manufacturing). 

 

 

 

 

 

 

 

 

 

 

Hình 2. Hình dáng bên ngoài máy gia công tia nước 
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Hình  3. Một số dạng ñầu cắt (vòi phun). 

Bảng . Các thông số kỹ thuật của máy gia công bằng tia nước của hãng AquaDAM. 

Dụng cụ. 

 Vòi phun có ñường kính 0,1 ÷ 0,4 mm. ðể có tia nước 
có ñủ năng lượng cho quá trình cắt cần cung cấp một áp 
suất lên ñến 400 MPa và vận tốc phun ra lên ñến 900 m/s. 
Lưu chất ñược tạo áp lực tới mức cần thiết nhờ một bơm 
thủy lực. ðầu phun gồm có ñai ốc hãm và vòi phun. 

 ðai ốc hãm ñược làm bằng thép không rỉ và vòi phun 
ñược làm bằng ngọc bích, hồng ngọc hay kim cương. Dùng 
kim cương thì kéo dài tuổi thọ nhưng giá thành rất cao. Hệ 
thống lọc ñược sử dụng ñể tách phoi phát sinh trong quá 
trình gia công. 

 Những lưu chất ñược dùng rộng rãi trong gia công 
bằng tia nước là các dung dịch polymer, vì chúng có xu 
hướng tạo thành một dòng kết dính. 

 

 

 

 

 

 

 

 

 

 

 

Hình 4. Cấu tạo ñầu cắt. 
Nguyễn Văn Tường 

Số ñầu cắt tối ña Kiểu Ap lực 

tối ña 

(bar) 

Công suất 
ñộng cơ 

(kW) 

Lưu lượng 

tối ña (l/ ph) 

ðường kính lỗ 
vòi phun tối ña 

(mm) Nước tinh 

khiết 
Nước có 

hạt mài 

2000 - 5.5 2 5,5 0,65 0,12 2 - 

4000 - 5.5 4 5,5 0,65 0,12 2 - 

4000 - 11 4 11 1,2 0,18 5 - 

4000 - 22 4 22 2,5 0,25 10 1 

4000 - 30 4 30 3,6 0,35 18 2 

4000 - 45 4 45 5 0,4 25 3 

4000 - 60 4 60 7,2 0,45 30 4 

4000 - 75 4 75 8,5 0,5 35 5 

4000 - 90 4 90 10 0,55 40 6 



GIỚI THIỆU PHẦN MỀM – TRANG WEB – SÁCH  

 

 14 

GIỚI THIỆU PHẦN MỀM SOLIDWORKS 

 SolidWorks phần mềm thiết kế ba chiều ñược sử dụng rất rộng rãi trong các lĩnh vực khác nhau 
như xây dựng, kiến trúc, cơ khí… ñược lập trình bằng ngôn ngữ Visual Basic và sử dụng các công nghệ 
mới nhất về lĩnh vực ñồ họa máy tính. Phần mềm SolidWorks do công ty SolidWorks phát triển là một 
trong những phần mềm thiết kế uy tín  nhất trên thế giới. Phần mềm này cho phép người sử dụng xây 
dựng các mô hình chi tiết 3D, lắp ráp chúng lại với nhau thành một bộ phận máy (máy) hoàn chỉnh, kiểm 
tra ñộng học, cung cấp thông tin về vật liệu… 

 Phần mềm SolidWorks cũng cho phép nhiều phần mềm ứng dụng nổi tiếng khác chạy trực tiếp 
trên môi trường của nó. SolidWorks có thể xuất ra các file dữ liệu ñịnh dạng chuẩn ñể người sử dụng có 
thể khai thác mô hình trong môi trường các phần mềm phân tích khác như ANSYS, ADAMS, Pro-
Casting…Trước sự phát triển lớn mạnh của phần mềm CAD SolidWorks, hiện nay nhiều phần mềm 
CAD/CAM ñã viết thêm các modul nhận dạng trực tiếp file dữ liệu SolidWorks… 

 Giao diện của chương trình rất thuận lợi cho người sử dụng, không bắt người sử dụng phải nhớ 
tên các lệnh một các chi tiết vì các biểu tượng của các nút lệnh trên các thanh công cụ ñã cho người sử 
dụng biết sơ bộ về chức năng của chúng. 

 

 
 

 Trong SolidWorks có 3 loại bản vẽ sau : 

- Part : ñược sử dụng ñể tạo các chi tiết riêng lẻ. Bản vẽ này thường xuyên ñược sử dụng ñể 
tạo các chi tiết 3D. 

- Assembly : bản vẽ này liên kết các chi tiết trong bản vẽ Part với nhau ñể tạo thành một bộ 
phận máy (máy) hoàn chỉnh. Bản vẽ này có sự liên kết với các chi tiết lại với nhau nên nếu có 
sự thay ñổi nào ñó từ bản vẽ Part thì chi tiết tương ứng trên bản vẽ lắp cũng tự ñộng cập nhật 
theo.  

- Drawing : chủ yếu dùng ñể biểu diễn các hình chiếu hoặc các mặt cắt từ bản vẽ Part hoặc 
Assembly. 
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 Sau ñây là một số mô hình chi tiết ñược vẽ bằng Solidworks :  

   

                  
 

 Phần mềm này tương ñối dễ sử dụng. Hiện tại trên thị trường ñã có sách tiếng Việt hướng dẫn 
sử dụng phần mềm này (do một nhóm tác giải trường ðại học Bách khoa Hà Nội viết) nhưng ở trình ñộ 
căn bản. Ngoài ra cũng dễ dàng tìm ñược các tài liệu hướng dẵn sử dụng bằng tiếng Anh trên mạng 
internet. 

 Trước những thế mạnh của SolidWorks, hiện tại nhiều trường ñại học, cao ñẳng kỹ  thuật ở Việt 
Nam ñã tiến hành mua bản quyền và giảng dạy cho sinh viên. Một số công ty tư nhân ở thành phố Hồ 
Chí Minh cũng tổ chức dạng phần mềm này (có ñăng báo). Rất nhiều công ty có vốn ñầu tư nước ngoài 
ở thành phố Hồ Chí Minh, Biên Hòa, Bình Dương sử dụng phần mềm này cho công việc thiết kế.  

 Nói chung ñây là phần mềm rất ñáng ñựoc nghiên cứu sử dụng.  
     Nguy�n Văn T��ng    
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GIỚI THIỆU SÁCH 
   

 HƯỚNG DẪN SỬ DỤNG SOLIDWORK TRONG THIẾT KẾ 3 CHIỀU 
 Tác giả : PGS.TS. Nguyễn Việt Hùng, TS. ðào Hồng Bách 

  Nhà xuất bản Xây Dựng, Hà Nội 2003 

          Giá : 29.000ñồng 

 

 

Nội dung sách bao gồm 182 trang với 10 chương như sau : 

Chương 1 : Môi trường làm việc 

Chương 2 : Thanh công cụ Sketch tools 

Chương 3 : Giới thiệu chức năng các công cụ tiện ích trong thiết kế 3D 

Chương 4 : Công cụ Extrude, Mirror, Pattern, Fillet, Chamfer, Hole, Shell 

Chương 5 : Sử dụng công cụ Revolve, Sweep, Loft 

Chương 6 : Công cụ Linear Pattern, Circular Pattern 

Chương 7 : Tạo tấm Shell Metal 

Chương 8 : Bản vẽ lắp 

Chương 9 : Bản vẽ kỹ thuật (Drawing) 

Chương 10 : Ví dụ tạo khuôn ñúc 

Sách ñược làm giáo trình cho các kháo ñào tạo sử dụng phần mềm Solidwork (trình ñộ cơ bản) 
do Trung  tâm Phát triển và Ứng dụng Phần mềm công nghiệp (Trung tâm DASI) Trường ñại học Bách 
khoa Hà Nội kết hợp với Công ty IME Technology của Malaysia tổ chức ñịnh kỳ theo yêu cầu của các 
doanh nghiệp. Nội dung sách dựa trên các tài liệu tiếng Anh phần Tutorial của công ty Solidwork (kèm 
theo khi cài phần mềm). 

ðây là tài liệu rất bổ ích cho sinh viên ngành cơ khí nói chung và cũng là tài liệu hỗ trợ giảng dạy 
cho giáo viên. Với phần mềm ñược cài sẵn và cuốn sách này, trong thời gian rất ngắn, mọi người ñều có 
thể tự học ñể tạo ñược các mô hình 3D tương ñối phức tạp. 

Nguy�n Văn T��ng 
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TRANG WEB CỦA TIẾN SĨ   ROBERT A. LEMASTER 

 Tiến sĩ  Robert A. LeMaster ñang giảng dạy tại khoa Kỹ thuật trường ñại học bang Tennessee, Hoa Kỳ. 
Trong trang web của ông, chúng ta có thể tải về nhiều bài giảng hay thuộc các lĩnh vực như : 

- Thiết kế máy : Engineering 473- Machine Design 

- Tự ñộng hoá : Engineering 475 -Automated Production Systems 

- Matlab 

Hãy vào ñịa chỉ  http://www.utm.edu/departments/engin/lemaster/ ñể tải thông tin. 

 

 

College of Engineering  
and Natural Sciences 

 

Spring 2001Spring 2001Spring 2001Spring 2001            
ClassesClassesClassesClasses     
ENGR 473 

Machine Design  

ENGR 475 

Automated Production Systems  

Matlab Notes   

 

 
Robert A. LeMaster, Ph.D.  

 
Engineering 473 
Machine Design 

SyllabusSyllabusSyllabusSyllabus ScheduleScheduleScheduleSchedule Project RequirementsProject RequirementsProject RequirementsProject Requirements 

ClassClassClassClass TopicTopicTopicTopic HandoutsHandoutsHandoutsHandouts HomewoHomewoHomewoHomeworkrkrkrk 

1111 Mechanical Properties of Ductile Metallic MaterialsMechanical Properties of Ductile Metallic MaterialsMechanical Properties of Ductile Metallic MaterialsMechanical Properties of Ductile Metallic Materials NotesNotesNotesNotes   

2 Influence of Fabrication Processes on the Strength of Materials NotesNotesNotesNotes   
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3333 Stress at a PointStress at a PointStress at a PointStress at a Point NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

4444 Stress Concentration Factors and Notch SensitivityStress Concentration Factors and Notch SensitivityStress Concentration Factors and Notch SensitivityStress Concentration Factors and Notch Sensitivity NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

5555 Steady Load Failure Theories ISteady Load Failure Theories ISteady Load Failure Theories ISteady Load Failure Theories I NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

6666 Steady Load Failure Theories IISteady Load Failure Theories IISteady Load Failure Theories IISteady Load Failure Theories II NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

7777 Steady Load Failure Theories Steady Load Failure Theories Steady Load Failure Theories Steady Load Failure Theories ---- Comparison with Experimental Data Comparison with Experimental Data Comparison with Experimental Data Comparison with Experimental Data NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

8888 Introduction to Fracture MechanicsIntroduction to Fracture MechanicsIntroduction to Fracture MechanicsIntroduction to Fracture Mechanics NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

9999 Fracture Mechanics and Steady Load Failure Theory SummaryFracture Mechanics and Steady Load Failure Theory SummaryFracture Mechanics and Steady Load Failure Theory SummaryFracture Mechanics and Steady Load Failure Theory Summary NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

10101010 FatigueFatigueFatigueFatigue, , , , Fatigue Machine SpecsFatigue Machine SpecsFatigue Machine SpecsFatigue Machine Specs NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

    11111111 Fatigue IIFatigue IIFatigue IIFatigue II NotesNotesNotesNotes AAAAnswersnswersnswersnswers 

    12121212 Crack PropagationCrack PropagationCrack PropagationCrack Propagation NotesNotesNotesNotes  

    13131313 Thick Walled CylindersThick Walled CylindersThick Walled CylindersThick Walled Cylinders NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

14141414 Compound Cylinders & DiscontinuityCompound Cylinders & DiscontinuityCompound Cylinders & DiscontinuityCompound Cylinders & Discontinuity Stresses Stresses Stresses Stresses NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

    15151515 Interference FitsInterference FitsInterference FitsInterference Fits NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

16161616 Stresses in Rotating DisksStresses in Rotating DisksStresses in Rotating DisksStresses in Rotating Disks NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

17171717 Shaft LoadingShaft LoadingShaft LoadingShaft Loading NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

18181818 Shaft AnalysisShaft AnalysisShaft AnalysisShaft Analysis NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

19191919 Keys & KeywaysKeys & KeywaysKeys & KeywaysKeys & Keyways NotesNotesNotesNotes AnsweAnsweAnsweAnswersrsrsrs 

20202020 SplinesSplinesSplinesSplines NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

21212121 Involute Gear Tooth Bending Stress AnalysisInvolute Gear Tooth Bending Stress AnalysisInvolute Gear Tooth Bending Stress AnalysisInvolute Gear Tooth Bending Stress Analysis NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

22222222 Involute Gear Tooth Contact Stress AnalysisInvolute Gear Tooth Contact Stress AnalysisInvolute Gear Tooth Contact Stress AnalysisInvolute Gear Tooth Contact Stress Analysis NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

23232323 Rolling Contact BearingsRolling Contact BearingsRolling Contact BearingsRolling Contact Bearings NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

24242424 Plane Surface BearingsPlane Surface BearingsPlane Surface BearingsPlane Surface Bearings NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

25252525 Hydrodynamic Bearings Hydrodynamic Bearings Hydrodynamic Bearings Hydrodynamic Bearings ---- Theory Theory Theory Theory NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

26262626 Hydrodynamic Bearings Hydrodynamic Bearings Hydrodynamic Bearings Hydrodynamic Bearings ---- Design Design Design Design NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

27272727 Power ScrewsPower ScrewsPower ScrewsPower Screws NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

28282828 Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners ---- Tensile and Shear Stress Areas Tensile and Shear Stress Areas Tensile and Shear Stress Areas Tensile and Shear Stress Areas NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

29292929 Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners ---- Tension Connections Tension Connections Tension Connections Tension Connections NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

30303030 Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners ---- Torque Vs Preload Relationship Torque Vs Preload Relationship Torque Vs Preload Relationship Torque Vs Preload Relationship NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

31313131 Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners ---- Shear Connections Shear Connections Shear Connections Shear Connections NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

32323232 Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners Mechanical Fasteners ---- Combined Tension and Shear Loading Combined Tension and Shear Loading Combined Tension and Shear Loading Combined Tension and Shear Loading NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

33333333 WeldsWeldsWeldsWelds NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

34343434 Eccentrically Loaded WeldsEccentrically Loaded WeldsEccentrically Loaded WeldsEccentrically Loaded Welds NotesNotesNotesNotes AnswersAnswersAnswersAnswers 

35353535 Helical SpringsHelical SpringsHelical SpringsHelical Springs NotesNotesNotesNotes  

 OneOneOneOne----Dimensional Heat Transfer Finite ElementsDimensional Heat Transfer Finite ElementsDimensional Heat Transfer Finite ElementsDimensional Heat Transfer Finite Elements NotesNotesNotesNotes OutcomesOutcomesOutcomesOutcomes 

 OneOneOneOne----Dimensional Heat Transfer Finite Elements IIDimensional Heat Transfer Finite Elements IIDimensional Heat Transfer Finite Elements IIDimensional Heat Transfer Finite Elements II NotesNotesNotesNotes  
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Engineering 475 
Automated Production Systems 

 

SyllabusSyllabusSyllabusSyllabus ScheduleScheduleScheduleSchedule ProProProProject Requirementsject Requirementsject Requirementsject Requirements 

ClassClassClassClass TopicTopicTopicTopic HandoutsHandoutsHandoutsHandouts HomeworkHomeworkHomeworkHomework 

1111 Introduction to AutomationIntroduction to AutomationIntroduction to AutomationIntroduction to Automation Notes   

2222 Automation and Control TechnologiesAutomation and Control TechnologiesAutomation and Control TechnologiesAutomation and Control Technologies Notes  

3333 Introduction to Hydraulic and Pneumatic Systems Notes   

4444 Hydraulic and Pneumatic Control Valves Notes  

5555 Pneumatic and Hydraulic System Schematics Notes  

6666 Electrical System Elements - Relays and Switches Notes  

7777     Introduction to PLCIntroduction to PLCIntroduction to PLCIntroduction to PLC's's's's NotesNotesNotesNotes  

8888 A<>D ConversionsA<>D ConversionsA<>D ConversionsA<>D Conversions Notes  

9999     Ladder Rung LogicLadder Rung LogicLadder Rung LogicLadder Rung Logic NotesNotesNotesNotes  

10101010 I/O AddressesI/O AddressesI/O AddressesI/O Addresses NotesNotesNotesNotes   

    11111111 PLC Timer InstructionsPLC Timer InstructionsPLC Timer InstructionsPLC Timer Instructions NotesNotesNotesNotes      

    12121212 PLC Timer ApplicationsPLC Timer ApplicationsPLC Timer ApplicationsPLC Timer Applications NotesNotesNotesNotes  

    13131313 PLC Counter InstructionsPLC Counter InstructionsPLC Counter InstructionsPLC Counter Instructions NotesNotesNotesNotes      

14141414 PLC Logic and Math InstructionsPLC Logic and Math InstructionsPLC Logic and Math InstructionsPLC Logic and Math Instructions NotesNotesNotesNotes       

    15151515 Introduction to RoboticsIntroduction to RoboticsIntroduction to RoboticsIntroduction to Robotics NotesNotesNotesNotes  
Lab Report Lab Report Lab Report Lab Report 

RequirementsRequirementsRequirementsRequirements 

    16161616 Jogging the RobotJogging the RobotJogging the RobotJogging the Robot NotesNotesNotesNotes      

    17171717 Programming the Robot: Motion Program InstructionsProgramming the Robot: Motion Program InstructionsProgramming the Robot: Motion Program InstructionsProgramming the Robot: Motion Program Instructions NoNoNoNotestestestes      

    18181818 Registers and I/O InstructionsRegisters and I/O InstructionsRegisters and I/O InstructionsRegisters and I/O Instructions NotesNotesNotesNotes  

    19191919 Branch InstructionsBranch InstructionsBranch InstructionsBranch Instructions NoNoNoNotestestestes  

20202020 Timer and Program Control InstructionsTimer and Program Control InstructionsTimer and Program Control InstructionsTimer and Program Control Instructions NotesNotesNotesNotes  

21212121 Macro InstructionsMacro InstructionsMacro InstructionsMacro Instructions NotesNotesNotesNotes  

22222222 Introduction to Servo Motors (Video)Introduction to Servo Motors (Video)Introduction to Servo Motors (Video)Introduction to Servo Motors (Video)   

23232323 Introduction to CNCIntroduction to CNCIntroduction to CNCIntroduction to CNC NotesNotesNotesNotes  

24242424 CNC Machine Feedback DevicesCNC Machine Feedback DevicesCNC Machine Feedback DevicesCNC Machine Feedback Devices NotesNotesNotesNotes  

25252525 CNC ProgrammingCNC ProgrammingCNC ProgrammingCNC Programming NotesNotesNotesNotes  

26262626 Drill & Mill CommandsDrill & Mill CommandsDrill & Mill CommandsDrill & Mill Commands NotesNotesNotesNotes  

27272727 Cutter CompensationCutter CompensationCutter CompensationCutter Compensation NotesNotesNotesNotes M & G CodesM & G CodesM & G CodesM & G Codes 

28282828 CAD/CAMCAD/CAMCAD/CAMCAD/CAM NotesNotesNotesNotes OutcomesOutcomesOutcomesOutcomes 

 

Nguy�n Văn T��ng 
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CÁCH BẪY LỖI CÁC GIÁ TRỊ NHẬP TRONG CÁC HỘP THOẠI 
KHI VIẾT CHƯƠNG TRÌNH AUTOLISP 

          Ths ðặng Xuân Phương 
 AutoLisp là một ngôn ngữ lập trình khá hiệu dụng ñối với các cán bộ và sinh viên ngành cơ khí cũng 
như kiến trúc hoặc xây dựng. Một khi công việc vẽ và tính toán thiết ñược lặp ñi lặp lại theo một mô hình nào 
ñó nhưng kích thước của nó có thể thay ñổi thì ta không nên ñi vẽ lại và cũng không thể dùng lệnh scale mà nên 
viết một chương trình AutoLisp ñể tự ñộng hoá công việc tính toán và vẽ. Nhiều người nói rằng cái chính của 
AutoLisp là sử dụng nó ñể tạo một macro lệnh của AutoCAD, ñiều này hoàn ñúng nhưng chỉ mới ñánh giá hết 
một phần ba về AutoLisp  bởi vì AutoLisp là một ngôn ngữ lập trình theo cú pháp danh sách. Nó có nhiều hàm 
toán học cơ bản, cũng có xử lý chuỗi, ñiều khiển các vòng lặp, ñiều khiển nhập, truy xuất cơ sở dữ liệu và ghi 
ñọc file v.v… Bên cạnh ñó một lợi thế ñặc thù của AutoLisp là ngôn ngữ lập trình này có thể sử dụng tất cả các 
lệnh của AutoCAD làm lệnh của nó. ðây là một công cụ cực kỳ hữu hiệu khi sử dụng AutoLisp ñể tự ñộng hoá 
việc tính toán và thiết kế ñồ hoạ trong kỹ thuật so với các ngôn ngữ lập trình có khả năng ñồ hoạ khác như 
Pascal, Visual C, VisualBasic... 

 Khi viết một chương trình AutoLisp kha khá, ñiều nhất thiết là phải có phần nhập dữ liệu. Việc nhập dữ 
liệu cho chương trình AutoLisp có thể thông qua hai cách: cách 1 thông qua dòng command line của AutoCAD, 
cách 2 nhờ các hộp thoại. Rõ ràng cách nhập dữ liệu thông qua command line bằng các lệnh như GetInt, 
GetReal, GetString v.v… tuy ñã ñược AutoLisp bẫy lỗi nhập dùm nhưng khá là không trực quan và thân thiện 
với người dùng ñồng thời nếu nhập sai thì không sửa lại ñược. Cách nhập dữ liệu bằng hộp hội thoại thì thân 
thiện và dễ dùng hơn như ta thường thấy trong rất nhiều lệnh phức tạp của AutoCad. Thế thì khi viết một 
chương trình AutoLisp cỡ vừa và lớn thì bạn thích sử dụng cách nhập số liệu nào? Câu trả lời dĩ nhiên là cách 
sử dụng hôp thoại vì nó làm cho chương trình mà bạn lập ra rất tiện ích và ñẹp mắt trong khâu giải quyết ñầu 
vào. 

Một ñiều cần chú ý là khi nhập dữ liệu bằng edittext thì AutoLisp chỉ nhận  dữ liệu dưới dạng chuỗi bới 
vậy ta  cần phải xử lý các giá trị nhập này ñể không gây lỗi cho chương trình khi chạy trong trường hợp ta nhập 
sai khiểu dữ liệu. ðây là một công việc cần thiết khi bạn muốn chương trình của mình hoàn chỉnh về mặt tin học 
ở ñầu vào của chương trình. Sau ñây sẽ trình bày một số ví dụ thường gặp khi bẫy lỗi các giá trị nhập trong hộp 
thoại của chương trình viết bằng AutoLisp. 

 Giả sử ta cần có một hộp thoại nhập dữ liệu như hình vẽ, bắt buộc số răng và moñun nhập vào phải là số 
nguyên (integer), hệ số chiều cao răng, góc nghiêng, góc bo ñỉnh, góc bo chân là số thực (real) và ñiều tất nhiên 
các giá trị này phải có ñộ lớn nằmn  trong một phạm vi nào ñó có nghĩa là phải lớn hơn một giá trị min và nhỏ 
hơn một giá trị max cho trước (khi dữ liệu yêu cầu nhập số thực – có dấu thập phân -  mà ta nhập số nguyên thì 
dĩ nhiên vẫn ñạt yêu cầu). Nếu ta nhập sai kiểu dữ liệu thì chương trình một mực bắt buộc  ta nhập lại cho ñúng 
rồi mới cho con trỏ chuyển sang edittext khác. Khi mới mở hộp thoại, con trỏ nằm ở edittext ñầu tiên, khi nhập 
xong số liệu và nhấn Enter thì con trỏ nhảy xuống ô khác, nếu muốn sửa lại số liệu của ô ngay kề trên thì ñưa 
con trỏ lên. 
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 ðể làm ñược công việc trên ñây có thể có nhiều cách nhưng ở ñây ñưa ra một cách thông qua một hàm 
kiểm tra nhập mà nó có thể dùng chung ñể kiểm tra số liệu nhập là số nguyên hay số thực và nó không chấp 
nhận kiểu dữ liệu không phải là số (ví dụ nhập nhầm hay cố tình nhập chữ) cũng như nó sẽ kiểm tra khoảng giá 
trị nhập cho phép. Hàm này như sau: 
 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 

(defun kt_nhap (val why key next real be_nhat lon_nhat)   
 (if 
      (not 
    (and 
       (cond ((= real 1) (or 
            (=(type (read VAL)) 'REAL) 
        (=(type (read VAL)) 'INT) 
           )) 
      ((= real 0) (=(type (read VAL)) 'INT))     
        ) ; end cond  
    (and (>= (atof VAL) be_nhat) (<= (atof VAL) lon_nhat)) 
    ) 
      ) 
   (progn  ; trường hợp có lỗi sẽ làm các việc trong nhóm  progn 
      (mode_tile KEY 3)  ; so 3: có một vệt sáng xanh chiếu sáng hết edit_text 

      (set_tile "error" "Gia tri nhap khong hop le, xin nhap lai") 
      (if (= WHY 2)  ; khi nguoi dung doi con tro sang edit_box phia tren 
    (set_tile "error" "Moi ban nhap lai gia tri moi") 
      )   ; end if      
   )      ; end progn 
          ; truong hop khong co loi (else of if) 

   (progn  
      (set_tile "error" "") 
      (if (or (= WHY 1) (= WHY 2))  ; bat dau gan gia tri cho bien neu khong loi 
     (progn 
   (set_tile KEY (rtos (atof (get_tile KEY)))) 
       (mode_tile NEXT 2)  ; chuyen con tro sang edit_box ke tiep 
       (mode_tile NEXT 3)  ; chieu sang edit_box ke tiep 
       
        )  ; end or 
  )  ; end if 
    )   ; end progn 
 )   ; end if lon nhat 
  ) 

 
Hàm kt_nhap có các tham biến cần truyền vào cho nó là: 
val  : value của edittext 
why : reason của edittext (ñể hiểu rõ thêm về các giá trị của reason, xem trong help ) 
key : key của edittext 
next : con trỏ sẽ nhảy ñến ô nhập tiếp theo nào khi nhấn phím enter 
real : số liệu nhập có phải là số thực không (1 là số thực; 0 là số nguyên) 
be_nhat : giá trị bé nhất cho phép   
lon_nhat : giá trị lớn nhất cho phép 

Kiểm tra số liệu nhập ñược thực hiện nhờ hàm biểu thức ñiều kiện trong hàm if từ dòng 2 ñến dòng 13. 
Nếu  ñiều kiện nhập không hợp lệ thì thông báo lỗi và buộc người dùng nhập lại ñược thể hiện trong nhóm lệnh 
progn từ dòng 14 ñến dòng 20. Sở dĩ phải nhóm các nhiều dòng lệnh thành một tổ hợp lệnh vì cấu trúc của lệnh 
if có cấu trúc (if test_expression  then_expression  else_expression ) buộc then_expression  và tương tự như vậy 
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else_expression cũng phải nhóm lại thành một list duy nhất. Nếu ñiều kiện nhập thoả mãn thì thực hiện các lệnh 
trong nhóm progn từ dòng 22 ñến dòng 32, ở ñây tạm thời tất cả các số liệu nhập ñược chuyển sang dạng chuỗi 
(dòng 26) ñể sau này sẽ chuyển sang các dạng thực hay nguyên và gán cho các biến số. 

 Cách sử dụng hàm kt_nhập (kiểm tra nhập): 

Sau khi load hộp thoại xuống bạn cần phải cho các edit_text hoạt ñộng hay nói chung là làm cho các tile 
hoạt ñộng lên bằng lệnh action_tile. Cấu trúc của lệnh action_tile là (action_tile     “key_của_tile”    
một_lệnh_cần_thực_hiện). Ví dụ từ dòng 11 ñến dòng 16 của hàm bay_loi, lệnh cần thực hiện trong  action_tile 
gồm hai lệnh con nên phải nhóm nó vào một progn. Lệnh con thứ nhất là gọi hàm kiểm tra nhập với các tham số 
cần  truyền là: 

 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

(defun c:bay_loi (/ dcl_id) 
   (load "kt_nhap") 
   (setq dcl_id (load_dialog "banh_dai_thang.dcl")) 
 (if (not(new_dialog "banh_dai_thang" dcl_id)) 
   (exit) 
 ) 
    (start_image "hinh") 
   (slide_image 0 -10 (dimx_tile "hinh") (dimy_tile "hinh") "dai_thang") 
   (end_image) 
     (mode_tile "so_rang" 2) ; ñưa con trỏ ề edittext ñầu tiên 
      (action_tile "so_rang_1" 
   "(progn   
    (kt_nhap (get_tile \"so_rang\") $reason \"so_rang\" \"so_rang_2\" 0 10 120) 
  (setq so_rang (atoi $value))  
   )" 
 ) 
   ;……………………………………. Tương tự dùng lệnh action_tile cho các title khác 
 ;……………………………………. như so_rang_2 
          (action_tile "modun" 
   "(progn (kt_nhap (get_tile \"modun\") $reason \"modun\" \"he_so_f\" 0 1 10) 
  (setq modun (atof $value))  
   )" 
 ) 
     ;……………………………………….. Tương tự dùng lệnh action_tile cho các title 

khác 
 ;……………………………………….. như he_so_f, goc_nghiêng, goc_bo_dinh, 

goc_bo_chân… 
    (start_dialog) 
  (unload_dialog dcl_id) 
) 
 

 
val = (get_tile \"so_rang\") why = $reason  key = so_rang 
next = so_rang_2   real = 0   min = 10  max = 20 

 (Chú ý: tên các key do người lập trình ñặt cho các tile khi viết file thiết kế hộp thoại DCL) 

 Lệnh thứ hai là chuyển dữ liệu từ chuỗi sang dạng dữ liệu thích hợp và gán cho biến và công việc nhập 
liệu ñã hoàn thành. 

 Hàm kt_nhap khá tổng quát nhưng rất gọn nhẹ, chỉ dần dùng một hàm này là bạnh có thể bẩy lỗi ñược 
dữ liệu nhập thường gặp trong bất kỳ hộp thoại AutoLisp nào mà bạn lập. ðể file  kt_nhap không quá phức tạp 
nên chỉ giới hạn việc bẩy lỗi thông thường. Nó còn giới hạn trong một trong các trường hợp sau: ví dụ như bạn 
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không muốn nhận số thực là số âm hay bạn muốn số liệu nhập phải chia hết cho 2 (số chẵn) chẳng hạn thì phải 
viết thêm vài lệnh vào phần kiểm tra ñiều kiện.  

Khi viết một chương trình AutoLisp có sử dụng hộp thoại bạn ñừng bẩy lỗi vội nếu như bạn chưa quen. 
Hãy tập trung và cái “ruột” của chương trình trước vì bạn là người soạn chương trình thì khó mà nhập nhầm 
ñược và là người biết rõ nhất nên nhập giá trị các biến là kiểu dữ liệu gì và phạm vi ra sao. Khi khi ra chạy ñược 
kết quả cần thiết thì bạn phải quay trở lại trau chuốt phần giao diện của chương trình trong ñó có việc bẩy lỗi số 
liệu nhập. Hy vọng những gì ñã trình bày ở trên sẽ giúp cho các bạn yêu thích tin học mà nhất là làm quen với 
AutoLisp ñỡ mất thời gian và công sức tìm tòi. Chúc các bạn thành công. 

 
Hướng dẫn sử dụng Pro/Engineer 2000i 

Basic Drawing 5 
Nguyễn Thắng Xiêm 

Có thể nói rằng việc hình dung từ bản vẽ 2D sang bản vẽ 3D là ñiều 
mà các bạn sinh viên luôn chăn trở, bài tập này tôi xin thể hiện chi tiết cầu nối 
(hình 1) ñể các bạn tham khảo. 
Bài tập này chủ yếu dùng các lệnh sau ñây: 
- Extrude: Tạo khối ñùn 
- Revolve: Tạo khối tròn xoay 

- Line → 2 Points: Tạo ñường thẳng qua hai ñiểm 
- Cut: Cắt bỏ 1 phần vật liệu khỏi vật thể cho trước 
- Modify: Sửa kích thước và chỉnh lý hình dạng của Sketch 
- Circle: Vẽ ñường tròn 
- Mirror: Dựng Sketch ñối xứng với 1 Sketch cho trước 
- Rectangle: Vẽ hình chữ nhật 
- Text: Khắc chữ (trong Sketch → Adv Goemetry) 
Bài tập ñược thực hiện như sau: 

   1. Chọn New từ menu File hay biểu tượng “Creat new object” → Xuất hiện 

hộp thoại New với việc chọn trước Part → Solid. Ở hộp Name gõ: Caunoi → 
OK (hình 2).  
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 2. Chọn Setup từ menu Part → Xuất hiện hộp thoại Units Manager → Chọn nút Systems of Units → Chọn 

Millimeter Newton Second (mmNs) → Set (hình 3) → Xuất hiện hộp thoại Warning → Chọn Convert 
Existing Number (Same Size) → OK (hình 4)→ Close.  

 

Hình 2 
 

Hình 3 
 

Hình 4 
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Hình 1 
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Centerline 

Hình 5 

 

Hình 8 

  3. Tạo mặt lồi thứ nhất: 
 Chọn Feature → Create → Datum → Plane → Default 
ñể tạo 3 mặt phẳng tham chiếu là DTM1, DTM2, 

DTM3 → Chọn Create → Solid → Protruction 

→ Revolve → Solid → Done ñể tạo khối tròn 

xoay → Chọn One Side → Done. Xuất hiện dòng 

nhắc Select or create a SKETCHING PLANE → 

Chọn DTM2 → Okay → Xuất hiện dòng nhắc 
Select or create a horizontal or vertical 
reference for sketching → Default. Nếu không 
muốn có lưới ô vuông thì ta bấm vào biểu tượng 

“Toggle the grid on/off” → off. 
 Specify Refs → Pick DTM1, DTM3 → 

Done sel → Sketch → Line → Geometry → 2 

Points → ðể vẽ ñường thẳng như hình 5 → Vào 
Dimension ñể lên kích thước với lựa chọn Normal, 
sau ñó Pick vào các ñiểm như hình 5 và kết thúc lệnh bằng nút giữa chuột hay nút trái + 

shift → Modify → Pick vào chỉ số kích thước rồi gõ lần lượt là 40, 30, 17 (hình 5) → Sketch → Line → 

Centerline → 2 Points chọn 2 ñiểm bất kì trên ñường Centerline → Regenerate → Done → Chọn 3600 → 

Done → OK. ChọnView → Default hay bấm Ctrl + D chi tiết sẽ hiện ra như hình 6. 
 
    
 
 
 
 
 
 
 
 
 
 
    

5. Chọn Create → Solid → Protrusion → Extrude → Solid → Done → One Side → Done → Pick vào ñáy 

lớn (hình 7) → Okay → Specify Refs → Pick DTM1, DTM2 → Done sel → Sketch → Line → Geometry → 

2 Points → Vẽ và Modify như hình 8 → Regenerate → Sketch → Arc → 3 Points → Vẽ như hình 9 → Done 
→ Blind → Done → Xuất hiện dòng nhắc Enter Depth gõ vào 80 → Enter → OK. Chọn View → Default chi 
tiết sẽ hiện ra như hình 10. 

 
Hình 9 

Hình 6 
Hình 7 
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    6. Tạo thêm mặt phẳng DTM4 

 Chọn Create → Datum → Plane → Offset → Plane → Coord Sys → Pick vào mặt DTM3 → Enter 
Value → Xuất hiện dòng nhắc Enter offset in the indicated direction, <ESC> to quit gõ vào –57 → Enter → 
Done. 
 7. Tạo mặt lồi thứ hai: 
 Chọn Copy → Mirror → Select → Independent → Select → Pick vào mặt lồi sẽ chuyển thành màu 

ñỏ → Done Sel → Done → Pick vào mặt phẳng DTM4. Chọn View → Default. Vậy là ta ñã tạo ñược mặt lồi 
thứ hai như hình 11. 
   8. Khoan lỗ: 
       Chọn Create → Solid → Hole → Straight → Done → Coaxial → Done → Pick vào ñường tâm A1 

hoặc A2 → One Side → Done → Thru All → Xuất hiện hộp thoại Enter DIAMETER gõ vào 32→ Enter → 

OK. Chọn View → Default. Ta ñã khoan lỗ ∅32 như hình 12. 
   9. Khoét rãnh: 
 Chọn Create → Solid → Cut → Extrude → Solid → Done → 

One Side → Done → Pick vào mặt trên của chi tiết → Xuất hiện mũi 

tên ñi xuống ta chấp nhận → Okay → Default → Specify Refs → Pick 
DTM1, DTM3 → Done sel → Sketch → Line → Geometry → 2 

Points → Vẽ hai ñường thẳng và sau khi Modify có kích thước chiều dài 

là 58, khoảng cách hai ñường là 30 như hình 13 → Regenerate → Chọn 

Sketch → Arc → 3 Points → Vẽ hai cung có bán kính là 15 (hình 14) 

→ Done → Okay → Blind → Done → Xuất hiện dòng nhắc Enter 
Depth gõ 12 → Enter → OK. Chọn View → Default. Ta có hình vẽ 
như hình 15. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hình 13 

 

Hình 14 

 

Hình 15 

 

Hình 11 

 

Hình 12 

 

Hình 10 
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   10. Khoét rãnh với ñộ sâu 24 
 Cách làm tương tự như mục 9 ta có hình vẽ như hình 16. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  11. Khoét chi tiết 
 Chọn Create → Solid → Cut → Extrude → Solid → Done → One Side → Done → Pick vào mặt 
bên của chi tiết → Xuất hiện mũi tên ñi vào ta chấp nhận → Okay → Default → Specify Refs → Pick DTM2, 
DTM4 → Done sel → Sketch → Rectangle → Vẽ hình chữ nhật và sau khi Modify có kích thước chiều dài là 

66, chiều rộng 50 như hình 17 → Done → Okay → Thru All → Done → OK. Chọn View → Default. Ta có 
hình vẽ như hình 18. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   12. Nếu muốn khắc tên chi tiết ta làm như sau: 
 Chọn Create → Solid → Cut → Extrude → Solid → Done → One Side → Done → Pick vào mặt 
trên của chi tiết → Xuất hiện mũi tên ñi xuống ta chấp nhận → Okay → Default → Specify Refs → Pick 
DTM1, DTM3 → Done sel → Sketch → Adv Goemetry → Text → Xuất hiện dòng nhắc Enter Text ta gõ 

CAU NOI → Chọn vùng cần ñặt chữ, ta chọn mặt trên của chi tiết → Xuất hiện lại dòng nhắc Enter Text, nếu 

ta không cần thêm chữ thì nhấn Enter → Done → Blind → Done → Xuất hiện dòng nhắc Enter Depth ta gõ 3 

→ Enter → OK. Chọn View → Default. Vậy là ta ñã hoàn thành bản vẽ như hình 19. 
 

 
 
 

 

Hình 16  

Hình 17 

 

Hình 18 
 

Hình 19 
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MỘT SỐ PHƯƠNG PHÁP GHI DUNG SAI KÍCH THƯỚC TRONG AutoCAD 
Nguyễn Thắng Xiêm 

Có hai cách ghi dung sai: 

- Ghi theo kiểu chữ (ví dụ: ∅30js6 thì kích thước và chữ ñều bằng nhau. ðối với cách ghi này thì 

cực kỳ ñơn giản nên tôi không ñưa vào bài viết này). 

- Ghi theo kiểu số (ví dụ: 70
02.0

01.0

+

−
 thì cỡ chữ dung sai bằng 0,7 cỡ chữ kích thước danh nghĩa). 

Trong các bản vẽ chi tiết máy, tôi nhận thấy hầu hết các bản vẽ khi ghi dung sai kích thước ñều ghi 

dưới dạng thủ công, dẫn ñến khi in bản vẽ có nhiều trường hợp xảy ra như: kích thước quá lớn còn dung sai 

thì lại quá nhỏ và ngược lại hoặc chữ ñâïm nhạt khác nhau (do chọn Font chữ khác nhau) và ñiều quan trọng 

là thao tác dịch chuyển kích thước, dung dai cho ñúng vị trí là rất lâu (tạm gọi là cách làm thủ công). Chính 

vì lý do ñó, tôi xin ñưa ra một số phương pháp ñơn giản có thể giúp cho các bạn sinh viên khắc phục ñược 

vấn ñề này. 

1. Phương pháp 1: Tạo trong Multiline Text (MTEXT) khi kích hay Edit Text (DDEDIT) 

+ Trường hợp 1: Nếu bạn ñã ghi kích thước của một trục hay một ñoạn thẳng, khi ñó bạn ñã có kích 

thước nhưng chưa có dung sai, ñể ñánh dung sai bạn làm như sau: 

 
Hình 1 

 

ðánh lệnh Edit Text hay Click vào biểu tượng  hoặc ñánh phím tắt “ED” (hình 1)→ Enter (hoặc 

Space) → con trỏ û       trở thành     → Click vào kích thước ta ñã tạo → xuất hiện bảng Edit text. 

Ví dụ 1: Nếu trục có kích thước 70, dung sai là 
02,0

01,0

+

−
 ta làm như sau: 

  Như trên khi ñã hiện bảng Edit Text và số 70 là kích thước ñã tạo (có kí hiệu < >)→ < >+ 0,02^ -

0,01 (“^” bấm: shift 6)→ ñóng khối +0,02^ -0,01 (hình 2)→ Click vào 
b

a
 (hình 3)→ < >

02,0

01,0

+

−
 (nghĩa là 

70
02,0

01,0

+

−
) → OK. 

 
Hình 2 

MText  



TIN HỌC  
 

 28 

 
     Hình 3 

Chú ý: ðể kiểm tra kích cỡ của dung sai và kích thước danh nghĩa 

có ñúng tiêu chuẩn hay không ta tiến hành làm các bước như sau: 

khi ñã ñóng khối như hình 3 ta bấm nút phải chuột → Properties → 

Hiện bảng Stack Properties → Text Size → Sửa thành 70% → OK 
(hình 4). 
Ví dụ 2: Nếu trục có kích thước 70, dung sai là –0.,01 ta làm như sau: 

Các thao tác ban ñầu như trên → < >^ -0,01 → ñóng khối ^ -0,01 

→ bấm vào 
b

a
 → < >-0,01 (hình 5) → OK.  

 
Hình 5 

Ví dụ 3: Nếu trục có kích thước 70, dung sai là +0.,02
 ta làm như sau: Các thao tác ban ñầu như trên → < 

>+0,02^ → ñóng khối +0,02^ → bấm vào 
b

a
 → < >+0.02 (hình 6) → OK  

 
Hình 6 

+ Trường hợp 2: Nếu bạn muốn ghi kích thước ở một chỗ bất kỳ thì ta ñánh lệnh Multiline Text 

(MTEXT) hay Click vào biểu tượng  hoặc ñánh phím tắt “T” → Enter (hoặc Space) → con trỏ      trở 

thành       → Tạo vùng cần ñặt kích thước → xuất hiện bảng MTEXT → Các bước còn lại tương tự như 

trường hợp 1. 

2. Phương pháp 2: Tạo trong Dimension Style 
ðầu tiên vào Format → Dimension Style (hình 7) hoặc bấm phím tắt “D” → Enter (hoặc Space) 

→ xuất hiện bảng Dimension Style (hình 8) → Modify → Tolerances → Tolerances Format có các lựa 

chọn: 

 Method: None (không ghi dung sai); Symmetrical (ghi dung sai ±); Deviation (ghi dung sai trên và 

dưới);  

Precision: phần thập phân từ 0; 0.0; 0.00; 0.000; 0.0000 . . . 

 Upper value: giới hạn trên 

 

Hình 4 
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 Lower value: giới hạn dưới 

 Scaling for height: tỷ lệ của dung sai so với kích thước (chọn khoảng 0,7) 

 Vertical position: bottom; middle; top (thường chọn middle) 

      
Hình 7       Hình 8 

 Ví dụ: ðể ghi dung sai 
02,0

01,0

+

−
 ta làm các bước như trên → ghi các số liệu như hình 9 → OK → Close 

→ Dimension → Linear (hình 10) hoặc Click vào biểu tượng  → bắt hai ñiểm cần ghi kích thước.  

      
Hình 9      Hình 10 

 
3. Phương pháp 3: Lập trình thêm cho AutoCAD bằng ngôn ngữ AutoLISP hoặc Visual LISP ñể thêm cho 

AutoCAD phần ghi dung sai vào kích thước ñã sẵn có. Trong mục này ta tạo các chương trình có tên 

DDIMTOLR.LSP và DDIMTOLR.DCL ñể thêm dung sai vào kích thước sẵn có. Chiều cao dung sai phụ 

thuộc vào biến DIMTFAC.  

Sau khi lập trình xong ta gọi chương trình bằng cách nhập dòng 

lệnh Ddimtolr, ñầu tiên ta chọn kích thước cần thêm dung sai, sau ñó hộp 

thoại Tolerance Format sẽ xuất hiện. Ta nhập các số liệu như trong hình 

11. 

4. Phương pháp 4: Tạo Block      

 Chú ý: Trong phương pháp 3 và 4 tôi xin ñưa ra ñể các bạn tham 

khảo, vì nó không có sẵn trong AutoCAD và ñòi hỏi bạn phải biết lập 

trình AutoLISP và cách tạo Block .  Bạn nào muốn biết thêm chi tiết về 

lập trình hay tạo Block trong AutoCAD thì xin liên hệ với tôi theo ñịa chỉ  
hoặc văn phòng Bộ môn Chế tạo máy. 

 Qua các phương pháp trên hy vọng các bạn sẽ hoàn thành bản vẽ 

ñược tốt hơn và nhanh hơn. 

         

        Hình 11 
 Nội san sau chúng tôi xin trình bày một số phương pháp ñánh ∅ và các kí tự khác khi Other trong 

Symbol của AutoCAD không mở ñược. 
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Grinding : Mài 

-Abrasive Chất liệu mài 
-Abrasive belt Băng tải gắn hạt mài 
-Abrasive slurry Bột nhão (mài) 
-Abrasive-belt grinding  Sự mài bằng băng tải gắn hạt mài 
-Accurate grinding Sự mài chính xác 
-Centerless grinding  Mài vô tâm 
-Coarse grinding  Sự mài thô 
-Cylinder wheel  ðá mài hình trụ 
-Cylindrical grinding  Mài tròn ngoài 
-Diamond-point dresser Bút kim cương sửa dá mài  
-Dick-type wheel ðá mài dạng ñĩa 
-Disk wheel ðá mài ñĩa 
-Dry/wet  grinding Sự mài khô/ướt 
-Face grinding  Sự mài mặt ñầu 
-Face-grinding spindle Trục chính mài mặt ñầu 
-Fine grinding Sự mài tinh 
-Flaring cup wheel ðá mài hình chậu côn 
-Flat surface grinding  Sự mài phẳng 
-Form grinding  Sự mài ñịnh hình 
-Grain Hạt mài 
-Grain size Cỡ hạt 
-Grain size index Ký hiệu cỡ hạt 
-Grind Mài 
-Grinding wheel   ðá mài 
-Grinding wheel  marking Ký hiệu ñá mài 
-Grinding wheel  structure Cấu trúc ñá mài 
-Grinding wheel grade Cấp ñộ cứng của ñá mài 
-Grindstone ðá mài 
-Infeed grinding Mài tiến ngang 
-Internal grinding  Mài tròn trong 
-Longtitudinal grinding Sự mài dọc 
-Longtitudinal table Bàn dọc 
-Magnetic chuck Mâm từ tính 
-Mouting of grinding wheel   Gá lắp ñá mài 
-Plane grinding  Sự mài phẳng 
-Plunge cut grinding Mài tiến ngang 
-Preliminary grinding Sự mài thô 
-Straight cup wheel ðá mài hình chậu  
                                                                    thẳng 
-Straight wheel ðá mài phẳng 
-Surface grinding  Sự mài phẳng 
-Thread grinding Sự mài ren 
-Traverse grinding Sự mài tiến dọc 
-Wheel shape  Dạng ñá mài  

 
 
 
 
 

Nguy�n Văn T��ng 

 



 
 

 Chịu trách nhiệm xuất bản 

TS. Nguyễn Văn Ba 
 
 

Tổng biên tập 

ThS. Nguyễn Văn Tường 
 

Ban biên tập 
ThS. Nguyễn Văn Tường 

ThS. Trần Doãn Hùng 
KS. Nguyễn Hữu Thật 

KS. Nguyễn Thắng Xiêm 
 
 

 
Danh sách các cộng tác viên : 

ðỗ ðình May (Bộ môn Vẽ kỹ thuật), Trần Hưng Trà, Phạm Bá Linh (Bộ môn Cơ học). ðặng 
Xuân Phương (Bộ môn Chế tạo máy), Bùi Thế Hùng, ðỗ trí Tuấn cùng tập thể lớp 42CT-1; 

Nguyễn Văn Biên , Lê Thanh Tòan, Lâm Văn Sơn cùng  tập  thể  lớp  42CT-2. 
 

 
 
 
 
Kính mời Quý thầy cô và các bạn sinh viên tham gia câu lạc bộ. Mọi chi tiết xin liên hệ ban 

biên tập hoặc e-mail về ñịa chỉ  caulacboctm@yahoo.com 
 
 
 
 
 
 
 
 
 
 
 


